
Verde Valley Computer Club 

See the AUGUST/SEPTEMBER 2010. VVCC  Events Calendar on page 3 

  

    

MEETING TIME  9:30 AM 

DEADLINE FOR ARTICLES TO DEADLINE FOR ARTICLES TO DEADLINE FOR ARTICLES TO DEADLINE FOR ARTICLES TO 
BE PRINTED IN THE BE PRINTED IN THE BE PRINTED IN THE BE PRINTED IN THE     

September CONNECTIONSSeptember CONNECTIONSSeptember CONNECTIONSSeptember CONNECTIONS:  
MONDAY, AUGUST 23, 2010  MONDAY, AUGUST 23, 2010  MONDAY, AUGUST 23, 2010  MONDAY, AUGUST 23, 2010  

AT 2:00 PMAT 2:00 PMAT 2:00 PMAT 2:00 PM    

In presenting this program, the Verde Valley Comput er Club is neither implying an endorsement of any p roduct 
offered nor validation of any information provided. "   

 

"CELL PHONES ARE    NOTNOTNOTNOT JUST FOR MAKING CALLS ANYMORE" 
 

Brandon Parker will be presenting this informative program. He is excited to be part of     
helping people understand cell phones.  He will be explaining different types of PDA phones, 
the different functions, fonts, and internet capabilities. 

Brandon is very knowledgeable in electronics. He and his father used to have a computer 
business in Washington State, so he is very familiar with the ins and outs of a computer. He is 
very cell phone savvy as well. Although cell phones change so often as technology advances, 
he understands and keeps up with the different phones, operating systems, and phone func-
tionality. Brandon does not work for any particular company that uses his knowledge, but in 
some cases,  he likes to do anything involving  electronics in his spare time just to stay fresh. 

You won’t want to miss this program, especially if you are planning to get a new cell phone 
soon.  Maybe the phone you have has some features you haven’t been using because you 
weren’t aware of them. 



VVCC Mentors 
Windows - Bob Efros: 
646-9182  bob@refros.com  
 
Front Page - Miles Standish: 
frontpage@vvcclub.com  
 
Adobe Photoshop Elements, 
WordPerfect, Word  2007  
Marny Zuercher 
marny71@gmail.com 
 
Any others out there 
willing to share their skills? 
What programs do you 
work with?  Share it! 
Being a Mentor doesn’t 
mean you have ALL the  
answers just a willingness 
to help someone. 

 
VVCC Contacts 

president@vvcclub.com 
vicepresident@vvcclub.com 
secretary@vvcclub.com 
treasurer@vvcclub.com 
past-president@vvcclub.com 
sig@vvcclub.com 
frontpage@vvcclub.com  
DOQ@vvcclub.com 
equipment@vvcclub.com 
membership@vvcclub.com 
editor@vvcclub.com 
publicity@vvcclub.com 2010 OFFICERS 

 
President: Jerry Miller 
Vice President:  Bob Efros 
Treasurer:   Lee Andress 
Secretary: Del Rosenwasser 

 

 
  

IN  SYMPATHY 
 

Words cannot express the sorrow we feel when a friend or loved is 
taken from us.  However, a hug or smile is always welcome. 

 
 

Charles “Skip” Bemis, passed away June 16, 2010 in Flagstaff. Skip 
held the office of  President of our Computer Club several years ago. 
We wish to  extend our condolences to his family. 
 
 
Another member, Dorothy Gericke passed away Saturday, July 17, 
2010. She is survived by her husband, Frank.  Our sincerest thoughts 
and prayers are with Frank.   
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EDITOR ON VACATION!  
 

Leo and I are going to be gone 
the month of September.  Lisa 
Packard has volunteered to do 
the Connections for me. 
Please, Please help Lisa by  
getting articles to her  

!ON TIME! 
This is not the easiest task in the 
world, and I am ever so  
thankful  that she is willing to 
do this.  It seems the busiest 
people are the ones who say, 
“Yes, I can do that.” 
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VERDE VALLEY COMPUTER CLUB              AUGUST 2010AUGUST 2010AUGUST 2010AUGUST 2010 
      Sunday              Monday          Tuesday        Wednesday          Thursday           Friday              Saturday     
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30 
 
 

31     

    1 2 
BOARD 

MEETING  
6:30 PM 

3 
WINDOWS 

SIG 
4:00 PM 

4 

5 6 
 

7 8 
 BEGINNERS 

CLASS 
       4:15 P.M. 

 

9 
 

10 
INTERNET 

SIG 
4:00 PM 

11 

12 
 
 
 
 

13 
 

14 15 
BEGINNERS 

CLASS 
       4:15 P.M. 
 

16 17 
SPREAD-
SHEET 

SIG 
4:00 PM 

18 
 

GENERAL  
MEETING 
9:30 AM 

19 
 

20 
 

21 
DEADLINE     
FOR CON-
NECTIONS 
     2:00 PM 

22 
BEGINNERS 

CLASS 
       4:15 P.M. 
  

23  
 
 

 

24 
 

25 

26 
 

27 
 
 

28 29 
BEGINNERS 

CLASS 
       4:15 P.M. 
  

30 SHUTTER-
BUG/PHOTO-
GRAPHY SIG 

6:00 PM 

  

   Sunday      Monday       Tuesday        Wednesday      Thursday            Friday  Saturday 

SEPTEMBER  2010SEPTEMBER  2010SEPTEMBER  2010SEPTEMBER  2010    
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The VVCC  President’s  Bits and BytesThe VVCC  President’s  Bits and BytesThe VVCC  President’s  Bits and BytesThe VVCC  President’s  Bits and Bytes    

  

THIS MONTH ONLY!  THIS PAGE IS THE EDITOR’S PAGE 

Jerry had other things come up and could not contribute this time.  Not to worry, these things happen and I can 
do this for him.  Hope you don’t mind that I took the opportunity to make this page mine this time. 

Page 2 lists your officers  and if you read it, you will notice there has been a couple of changes.  Due to       
personal reasons, Consuelo Langholz tendered her resignation as President.  Our Vice-President, Jerry Miller 
has agreed to take over the presidency for the remainder of the term.  Bob Efros has agreed to be our Vice-
President.  They need our support for stepping up to the plate. 

On the subject of officers of our club:  It will soon be time to get a nominating committee.  Our by-laws state 
that you can only hold an office for 2 consecutive years and then you have to be replaced.  Del, our secretary is 
serving her second year.  I took over the secretary position from her and when I wanted to be relieved to do 
only the Connections, she took it again.  It is time for someone to be thinking of this position.  Del is very   
organized and has excellent short cuts she will share with you to make your position easy. 

Have you ever thought of being President?  Don’t wait to be asked—volunteering for the position doesn’t 
mean you think you are great stuff—just means you think you have something to contribute if you have help.  
As a board member, you get FREE computer aid.   

Do you really get help if you take on a position or is it lip-service?  Speaking from experience, help is ready, 
willing and able to come to your aid.  Do you get the idea that I like this club?  I  hope it is obvious! 
<><><>><><><><<<>>>><><>>><><><<>>><><>><<><><<>><><>><><<><>><><><><<><>><><  

VOLUNTEERS!VOLUNTEERS!VOLUNTEERS!VOLUNTEERS!    

If you enjoyed the Pot Luck and Sloppy Joes at the July 
meeting, this is the fellow to thank.  Dale Forbes will tell 
you that he doesn’t do the        computer thing, but he will 
do pot lucks.  Thank you, Dale.  If you would stand still, 
we could get a better picture. 

 

Our Publicity Man, Dave Olson is another of our volunteers 
that has been   doing a wonderful job.  He knows how to pro-
mote the club in the newspapers.  Thank you, Dave. 
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Membership Corner  Membership Corner  Membership Corner  Membership Corner  by by by by Myrelle McHaleMyrelle McHaleMyrelle McHaleMyrelle McHale    
 
Hello Members, 
Hope you are all having a really great summer. For those of you on vacation or those 
 of you who had a bout with the summer flu, you really missed a nice Pot Luck Party.  
Our attendance was small but the food was GREAT ! Our Pot Luck Co-ordinator,  
Dale Forbes, once again handled the entire party (from prep to presentation) with style. 
 Thank you Dale. 
Now we are going to get on with the rest of the year. 
I want to personally thank all of you who answered my request for suggestions for a  
possible new column in our newsletter. Some of the titles were extremely creative.  
Also, the questions posed will be presented and answered. 
For those of you who may not have received the note, I am asking for questions from members who 
have concerns about their computers or software or even hardware, to submit them to me and I will do 
all I can to get the answers for you. Kind of like a mini Q&A where you can ask the questions of the 
VVCC at any time. You don't have to wait for a meeting or SIG. Please submit specific and concise 
questions and I will try to find the answer(s) for you. Just send your questions to me at: 
                                                                Membership@vvcclub.com 
I want to also say a personal “Thank You” to Richard Gohman. I had asked him to help find a cute 
cartoon for my note and then to send it out to the members. Little did I know the commotion it would 
cause. Seems several of you just hit the “Reply” button and the mail went to Richard and not to me. 
He was quite professional in the handling of the unexpected mail. But this is not his responsibility and 
I apologize for the extra work for him. 
As always, I am extremely interested in hearing from the members as to possible ways to increase our 
group. Many of you are loyal supporters of the VVCC and have been for years. Some of you are new 
and we hope you stay with us. If you have any thoughts of what can be done to create interest and 
attendance to our meetings, please drop me a line. Same address as above. 
Hope to see you at the next meeting. 
                                                                                 Myrelle 
<><><><><><><><><><><><><><><><><><><><><><><><><><><><><><><><><><><><><><><> 
 
 

     GENEALOGY SIG 
 
Is there any interest in genealogy?  Marny Zuercher is willing to take on this SIG if there are people inter-
ested.  Probably on a Monday Night at 6:00 p.m. starting in October. 

 
Call 928-301-0591  

 
or e-mail  editor@vvcclub.com 
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NEW  COLUMN FOR NEWSLETTER     ??? 
 
Many of you have responded to my request for questions and suggestions for a title for a possible new column for our newsletter. 
                                                                                              Thank you. 
 
One of our members has gone one step further and is suggesting  (and recommending) the use of the following link: 
 
                                                                                 www.giveawayoftheday.com 
 
                            It provides a service that gives away a free program almost every day.      Thank you Chuck LeBeau. 
 
You might want to give it a try.     Then let us know so we can share with other members.  Please continue to send your questions to 
me at:     
                                                                                 membership@vvcclub.com 
Thank you.                                      
<><><><><><><>><><><><><><><><<><><><><><><><>><><><><><><><><><><><><><><><><><><><>> 
Several months ago I started asking all of you to contact me if you had any ideas on how to increase          
membership.  I also asked if you had any suggestions on different things we could do for you that would be of 
interest.   Things like new classes, new programs etc., etc.       
 
FINALLY, after months and months, I received my FIRST e-mail from a member with a suggestion or 
two.   Thank you 
Brenda and Lloyd Collins...................... 
 
How many times have you gone to a meeting and wanted to ask a specific question about your computer and 
then forgot?   Happens to me all the time.   This is not necessarily a senior moment.    We get caught up in the 
meeting, the program and the door prizes.  Easy to forget to ask the question that has been bugging you for 
days  (or months). 
 
It has been suggested that we have a regular column appearing each month in the CONNECTIONS.   A Q&A 
from the members to the mentors.    I have volunteered to field the questions, contact the mentors and write the 
answers for you.   All you need to do is send your questions to me:     
                                                                    membership@vvcclub.com 
 
How easy can that be?  You can even write and send the question at midnight in your jammies and I will get it 
and follow up for you.    
 
So while you are writing that question, please give some thought as to what we can name this column.   We are 
open for all suggestions.    
 
This is a good way for all to be involved.   It is YOUR club.   Use it.    Learn thru membership.   Any           
suggestions for future programs, mini-classes, downloading free programs  (good and not so good) can all be 
sent to me and I will be delighted to respond.    I may not know the answers but I know how to contact those 
who do  (know).     This is a good idea.    
Let's run with it. 
 
Hope to hear from you soon.                            membership@vvcclub.com 
 
 
Myrelle  
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.  

 
If you still use a computer with Windows XP, please make sure you update all of your computers to Windows 
XP SP3 to continue to receive updates from Microsoft since support for XP SP2 is ending on July 13, 2010. 
  
This does not mean you cannot use Windows XP, it just means that if you have not installed the SP3 
update, you will no longer get any security or patch updates.  This could leave your computer vulner-
able to malware. 
  
To check and see if your computer has the SP3 update, locate your "My Computer" and right-mouse 
click on it.  Then choose "properties" from the menu.  You should see a dialog window similar to 
this.... 
  
  
Note that in the upper right it tells me that I have Windows XP Home Edition, Version 2002 with   
Service Pack 3. 
  
If you don't have Service Pack 3, you can get download instructions from: 
  
 

                  http://tinyurl.com/6yqqcb  
  
  
  
  
 In addition, all support from Microsoft for Windows 2000 ends on July 13, 2010. 
 

Submitted by: Richard Gohman 
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VVCC  
Mailing Address: 

Mail  inquires, sug-
gestions and items 

of  interest,  
to the club,  

 

VVCC 
PO BOX 3023 

 COTTONWOOD, AZ 
86326  

 
Or  e-mail us at 

info@vvcclub.com 

VVCC Beginners 
Class  

 
 

A popular series of six hands-on ses-
sions designed for the beginning 
computer users. Classes are held on 
Wednesdays from 4:15 to 6:15 PM at 
the Cottonwood Middle School  
Computer Lab, Mingus & 6th.  
More information is on our web site!  

 
Please call Sharon Skinner at        

649-2993 after 3:00pm 
Or Barbara Wall at 567-4222 

To preregister for each series of  
classes 

 
The Series repeats. 

 
Beginners class dates: 

 

(New classes will begin in 
September) 
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Join Us for a Special 

Interest Group SIG) 
Learn from each other! 

Visit our Web site for more 
SIG info. Attendees are    
encouraged to print out     
handouts prior to classes.  

 
 Word Processing: 
Dick Gohman   

 

Internet: Dick Gohman 

 

 

Windows: Bob Efros 

 

Beginner Classes:  

 

Digital Camera: Leo  

Zuercher  

 

PHOTOGRAPHY SIG: 
Hal Rosenwasser. 

 

 

Web Site Team:  
Lisa Packard 

 

There are handouts for the 

classes that can be 

downloaded from the club 

website:        

 

www.vvcclub.com 

  
SIGS AND BEGINNER 
CLASSES  WILL START 
AGAIN IN SEPTEMBER 
 
HOPE YOU’RE HAVING A 
GOOD SUMMER! 
. 
 
 
 
 
 

 The Secretary’s Corner  By Del Rosenwasser 

 

 

 
 
 
 
Just between us girls: 
 
In this life I'm a woman. In my next 
life, I'd like to come back as a bear. 
When you're a bear, you get to       
hibernate. You do nothing but 
sleep for six months.  
I COULD DEAL WITH THAT. 
 
Before you hibernate, you're supposed to eat yourself stupid. 
I COULD DEAL WITH THAT. 
 
When you're a girl bear, you birth your children (who are the 
size of walnuts) while you're sleeping and wake to partially grown, 
cute, cuddly cubs.  
I COULD DEFINITELY DEAL WITH THAT. 
 
If you're a mama bear, everyone knows you mean business. You 
swat anyone who bothers your cubs. If your cubs get out of line, 
you swat them too.  
I COULD DEAL WITH THAT. 
 
If you're a bear, your mate EXPECTS you to wake up growling. 
He EXPECTS that you will have hairy legs and excess body fat. 
 

YUP, GONNA BE A BEAR! 
 
 
Until then, here are the winners of our Pot Luck door prizes: 
Book "VIRTUALIZATION" and MEMOREX LABEL MAKER - Joan 
Lambard 
8" DIGITAL PHOTO FRAME - Leo Zuercher 
TEACH & TALK ACTIVITY LAPTOP - Consuelo Langholz 
SILVER AND TURQUOISE PENDANT (Donated by Lisa Hering's 
ALLEY CAT GIFT SHOP in Oldtown Cottonwood) - Adrienne 
        Pritchard 
MICROSOFT WIRELESS MOUSE - Al Quadracci 
KENSINGTON SHARE CENTRAL - Myrelle McHale 
MEMOREX DVD-R PACK - Adrienne Pritchard and Judy Thomas 
PORTABLE DESK TOP - Hal Rosenwasser 
MATRIX CD/DVD STORAGE CASE - Lois Kelley 
PRINTER PAPER - Louise Evans, Lovey Jones and Gordon Schneider 
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 INSERTING A NON-BREAKING HYPHEN 
 
When Microsoft Word calculates line length and wraps text to the next line, it tries to wrap (or break) the line at a space 
or a hyphen—a dash. Sometimes, however, you may not want Word to break a line at a dash. For instance, dashes are 
used in telephone numbers, and you might not want a line to break in the middle of a telephone number. 

The answer is to use non-breaking hyphens instead of regular dashes when you don't want Word to break a line at the 
hyphen. To do this, hold down the CTRL  and SHIFT  keys as you type the dash (this is the same as typing CTRL  and an 
underscore). Word will then not break the line at that point. 

You can also insert a non-breaking hyphen by following these steps: 

1. Choose Symbol from the Insert menu or, in Word 2007, display the Insert tab of the ribbon, click Symbol in 
the Symbols group, and finally click More Symbols. This displays the Insert Symbol dialog box. 

2. Click on the Special Characters tab. 

 

The Special Characters tab of the Symbol dialog box. 

3. Highlight the Nonbreaking Hyphen character. 

4. Click on Insert. 

5. Close the dialog box by clicking on Cancel. 

Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of free Microsoft Word tips can be found 
online at http://word.tips.net. 
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                                                 INDENTING CELL CONTENTS 
Microsoft Excel allows you to format the contents of a cell in a myriad of ways. One of the formatting options you can 
apply is to indent the contents of a cell by a certain amount. This is similar to indenting done in a word processor, such 
as Microsoft Word, except that the indenting is specified in a number of characters, not in a linear distance such as 
inches or points. 

To set the indent to be used in a cell, follow these steps: 

1. Select the cells you want to format. 

2. Display the Format Cells dialog box. (In Excel 2007 display the Home tab of the ribbon and click the small 
icon at the lower-right corner of the Number group. In older versions of Excel choose Cells from the Format 
menu.) 

3. Make sure the Alignment tab is selected. 

 

The Alignment tab of the Format Cells dialog box. 

4. In the Horizontal drop-down list, choose Left (Indent). If you are using Excel 2002 or a later version, you can 
also choose Right (Indent). 

5. Using the Indent control, specify the number of characters by which the cell contents should be indented from 
either the left or right side of the cell. You can pick any whole number between 0 and 15. 

6. Click on OK. 

Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of free Microsoft Excel tips can be found 
online at http://excel.tips.net. 
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Verde Valley Computer Club 
A Nonprofit Corporation 
PO Box 3023  
Cottonwood, AZ  86326 

PRSRT Nonprofit Org 
 U.S. Postage Paid 
Cottonwood, AZ  86326 
Permit No. 28 

Note from the Editor… 

The next newsletter deadline for all   

submissions:  

MONDAY, AUGUST 23, 2010 - 2 PM 

Verify that your e-mail and 
mailing addresses are cor-
rect. Send corrections or  

changes to  
membership@vvcclub.com  

@ 

 
 

 
 
 

When you are done  
reading 

the  
Connections 
Pass it on to a  

Friend or Neighbor  

 

THIS SPACE IS SAVED FOR 
NEW MEMBERS! 

 
MAYBE NEXT MONTH! 

 
LET PEOPLE KNOW WHAT 

THEY’RE MISSING! 


